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1 GETTING STARTED 

This section provides start-up instructions for using the Oracle applications. 

 

1.1 Sign-On to Cloud applications  

To log into the application:  

1. Open internet browser window. 

2. Enter the below URL:  

No. URL Type URL Link 

1.  UAT  https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/  

Table 1: Direct Login URL 

 

3. The Sign In page appears. Enter your User ID and Password.  

 

Figure 1: Oracle Cloud Sign-In Page 

 

4. Your user ID and password are case sensitive. Passwords always appear as asterisks 
in the display as you enter them.  

5. Tab to or click the  button to sign in. 

6. Personal Homepage dashboard screen appears with CLOUD privilege access. 

 

 

 

 

https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/
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1.2 Navigating from Personal Home Page to Applications 

After you log in to Oracle Applications, your Oracle Financial Cloud Home page is displayed. 

All the functionality within the Oracle Cloud applications revolves around homepage which you 

can personalize. From here you can: 

1. Get a quick glance at your work-related conversations and announcements. 

2. Use the Application Link icons to navigate to pages and dashboards to perform your 

day-to-day activities.  

3. Access the Navigator to access any additional applications that are not available in the 

application section on the home page 

4. Favourited list of quick actions to quickly perform some key tasks. 

Note: The exact appearance of your windows may vary depending on your personalization 

and roles that is assign to you. 

 

Figure 2: Personal Home Page 

 

 

Figure 3: Navigation Tools in the Global Area of the Home Page 

 

Once you have set your homepage as the Newsfeed Home Page, then it will come with 
different sections. 
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1.2.1 Apps Section  

 

Figure 4: Apps Section 

 

Within the Apps section, you have various icons that can be used to start navigating into 
the different work areas of an application. For example, if you would like to navigate to the 
Invoices work area within Payables, you will select your application as Payables. And you 
will choose Invoices in the Apps section. When you select Invoices, the system takes you 
to the Invoices work area, where you can perform various activities, such as recording 
invoices, managing invoices, generating accounting for your invoices, etc. Once your work 
has been completed, you can go back to the home page by using the home icon. 

You can also access the apps via the Navigator  

Here, the access is granted to various work areas based on the roles that have been given 
to your user account. You have the flexibility to personalize the App section. You can 
decide what you want to show within these springboard icons and what you want to hide. 
If you are an order regular visitor to the Payment work area, you mostly work with 
Payable’s dashboard invoices, you can hide the payments by clicking on this icon. So, it 
will not be shown in the apps icon but only accessible through the Navigator. 

 

1.2.2 Things to Finish Section  

 

Figure 5: Things to Finish Section 

 

The Things to Finish section provides you with a count of any pending notifications that 
are assigned to you and may require an action from you. Account Link name created 
by me lists the approval requests that you have created. You can click the link to 
navigate to a full list of notifications pertaining to that account. Then the items listed in 

Click this to personalize  
springboard 
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the Things to Finish section are same as the notifications that are listed in the global 
header.  

The same information is available when you click on notifications icon. You can access 
the same number of notifications from here, as well as from the Things to Finish 
section. The list displays the latest notification first and allows you to scroll horizontally 
to view more notifications.  

You can clear a notification from the list by clicking the Close icon. When you clear a 
notification, the count does not change, since no action is taken on that notification. If 
you click on you will get a listing of all the notifications that are either FYI or the 
notifications that require an action from you. When you click on the link it opens the 
notification and you can get the details of the notification. If you are satisfied, you can 
either approve it or you can either reject it. Once the notification is read then the count 
will change. 

 

1.2.3 Analytics Section  

 

Figure 6: Analytics Section 

 

As far as financials is concerned, there are currently 5 choices of analytics display. 
And they are Cash Management Infolets, General Accounting Infolets, Service Infolets, 
Source to Settle Infolet, Plan to Produce Infolers and Order to Cash Infolets. You can 
personalize the Analytics section and decide which infolet should be visible, which 
should not be visible.  

 

1.3 Creating Favorites and Setting Preferences  

1.3.1 Creating Favorites 

Each user has their own favorites and adding favorites is easy in cloud: just go to your 
favorite work area or task page. Click on the favorite icon and click Add to Favorites.  
By this you get to your favorite pages directly and easily when you click the favorite 
icon. You can remove unwanted pages by clicking Manage Favorites. 
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Figure 7: Creating and Managing Favourites 

 

1.3.2 Set Preferences 

Select Preferences to set personal options such as regional, language, accessibility setting, 
watchlist and etc as shown in the list in Figure 8. You can also reset your password from the 
Preferences page. To get into set preferences, click on setting and action dropdown menu 
click on Set Preferences. 

  

Figure 8: Setting Preferences 

1.4 Overview of Using Work Areas to Streamline Business Processes 

Use work areas to gain instant insight into your business and identify potential problems with 
processing transactions.  

Work areas can include the following: 

• Infotiles 

• Content area 

• Actions toolbar 

• Tasks panel tab 

• Search panel tab 

• Reports and Analytics panel tab 
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Figure 9: Invoices Work Area  

 

Infotiles 

Summarize a high volume of transactional information. You can quickly identify potential 
problems and prioritize your daily activities by scanning the infotiles and accessing transaction 
details. 

For example, select an infotile to display corresponding transactional information in the content 
area. You can also click links in the infotile to filter the records in greater detail in the content 
area. 

 

Content Area 

The content area displays transactional information related to the infotile you select. You can 
review the detailed information and take the necessary action. 

For example, click the item link in the table to drill down to transaction-level information. You 
can perform multiple actions on the transaction, such as editing the invoice, approving, or 
rejecting the transaction, and posting the invoice to the ledger. 

 

Actions Toolbar 

Use the actions toolbar to perform a range of activities on one or more rows you select in the 
content area. 

For example, select a transaction row and use the View menu to view the transaction in more 
detail. You can export the data to an Excel worksheet, detach the pane, approve, or reject one 
or more transactions, as well as apply additional filters. 

 

Tasks Panel Tab 

The Tasks panel includes tasks that are related to the work area and that you have access to 
perform. 

For example, create an invoice, review journal entries, create mass additions, and manage 
accounting periods within a task panel. 

 

 

Search Panel Tab 
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Search enables you to find a specific transaction using search criteria related to the work area. 

For example, search on an invoice number or supplier in the Invoices work area to find a 
specific transaction. 

 

Reports and Analytics Panel Tab 

The Reports and Analytics panel tab contains predefined reports as well as a folder for you to 
set up your own reports. 

For example, use the predefined reports to perform a deeper analysis on invoices above a 
certain dollar amount without a PO. You can also access reports that you have copied and 
modified and stored in your own folder. 

 

1.5 Scheduled Process 

Scheduled processes do tasks that are too complex or time-consuming to do manually, for 
example importing data or updating many records. You can run scheduled processes on a 
recurring schedule and send notifications based on how the process ends. Some scheduled 
processes give you printable output. Those processes might have Report in their name. 

 

Jobs  

Each scheduled process that you run is based on a job. The job is the executable that controls 
what the process can do and what parameters and other options you have for the process. A 
job set contains multiple jobs. 

Job definitions can be set on Oracle Business Intelligence Publisher reports so that people 
can run the reports as scheduled processes. 

 

Process Sets 

A process set is a scheduled process that is based on a job set. So, when you submit a 
process set, you are running more than one job. 

Note: When you submit certain scheduled processes, the job logic causes other processes to 
automatically run. But in this case, you are not submitting a process set that includes those 
other processes. 

 

Submission 

When you submit a scheduled process, you can use its parameters to control which records 
are processed and how. Some scheduled processes do not have parameters. 

As part of the submission, you can also set up a schedule for the process, for example to run 
once a week for two months. Every time a process runs, there is a unique process ID. 

 

Output 

Some scheduled processes provide output in PDF, HTML, and other formats. For example, a 
process can import records and produce output with details about those records. There are 
many types of output, for example a tax document or a list of transactions. 

Process Sets 
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A process set is a type of scheduled process that is based on a job set and contains at least 
two processes. So, you can run many processes in one go, for a specific purpose. These 
processes run in a certain order, in serial or parallel, or by some other logic.  
Process sets can have any number of individual scheduled processes and even other 
process sets.  
 
 
To Submit Scheduled Processes 
 
Click Navigator > Tools > Scheduled Processes. 
 

 

Figure 10: Scheduled Processes Overview Page  

 

1. On the Scheduled Processes Overview page, click Schedule New Process. 

2. Leave the type as Job, enter the process that you want to submit, and click OK. 

3. In the Process Details dialog box, enter at least the required parameters, if any. 

Some processes have no parameters at all. Some parameters depend on other 

parameters. For example, date range parameters might appear only after you select 

By Date for another parameter. 

4. Click the Advanced button if you want to define the schedule, notifications, or 

output. Continue to the next steps. Or just skip to the steps for  

5. Click Submit, to run the process once as soon as possible with the default output. 

 
Define the Schedule 
 
Set up a schedule to run the process on a recurring basis or at a specific time. Use the 
Process Details dialog box in Advanced mode. 
 

1. Open the Schedule tab and select Using a schedule for the Run option. 

2. Select a frequency. 

3. Select User-Defined if you want to enter the exact dates and times to run the 

process. 

4. You can select Use a Saved Schedule to use an existing schedule if there are any. 

5. Depending on the frequency, define when the process should run. 

 
 
 
Define the Output 
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You can choose the layout, format, and destination for your output. Use the Process Details 
dialog box in Advanced mode. 
 

1. Open the Output tab, if available. 

2. Click Add Output Document. 

3. Change the name if you want. The name identifies this output document when you 

go to view output later. 

4. Select a layout if you have more than one to choose from. 

5. Select a format, for example one of these: 

 
PDF: Is the best option if you want to print the output. 

Excel: Supports embedded images, such as charts and logos, but can be opened 

only in Excel 2003 or higher. 

Data: Gives you report data in an XML file, which is used mainly for editing the report 

layout. 

 
6. Click Add Destination to send the output somewhere, for example to a printer or 

email address. You can add many destinations and send the output to all of them at 

the same time. 

 
Tip: You can also print the output as part of the steps for finishing the submission, 

instead of adding a printer destination here. 

 

To add more output documents, repeat steps 2 to 6. 

 
Set Up Notifications 
You can have notifications sent out depending on how the process ends. Use the Process 
Details dialog box in Advanced mode to set that up. 
 

1. Open the Notification tab. 

2. Click Create Notification. 

3. In the Recipient field, enter the user ID of the person you want to send the 

notification to. 

4. In the Condition list, select when to send the notification, for example when the 

process ends in error. 

5. Click OK. 

 
To send notifications to more people, repeat steps 2 to 5. 
 
Finish the Submission 
Follow these steps in the Process Details dialog box: 
 

1. Click the Process Options button if you want to define settings that affect the data to 

be processed. 

2. If the process gives you output and you want to print it, select the Print output check 

box and a printer. 

3. Select the Notify me when this process ends check box if you want to get an email 

notification. 
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4. Enter submission notes to capture any information you want to associate with this 

submission. You can use your notes to find this submission later. 

5. Click Submit. 

6. Click OK to confirm. 

 
Tip: Note down the process ID for your submission so you can easily find it later. For 
example, let's say you set the process to run once a week. If you later want to cancel all runs 
on this schedule, you need to cancel this original submission with this process ID. 
 
To Submit Process Sets 
 
To submit a process set from the Scheduled Processes Overview page: 
 

1. Proceed with the steps that you would follow to submit any scheduled process, but 

select Job Set for the Type option. 

2. In the Process details dialog box, set parameters for individual processes in the set. 

A process set itself does not have parameters. 

a. Select a process on the Processes tab. 

b. Enter parameters for that process, if any. 

c. Repeat for other processes in the set. 

3. Define the schedule, output, and notifications for the process set, as you would do for 

any scheduled process. 

4. Set any other options and click Submit. 

 
To Check Status 
 

1. Click Navigator > Tools > Scheduled Processes. 

The Search Results table shows processes that match the default saved search, Last 
24 hours. 

• The table might be blank if nothing was submitted. 

• If submission notes were entered when submitting the process, you can use 
the Submission Notes column to help identify the process. 

2. If you don't see the process, click the Refresh icon or use the Search section. 

3. Do any of these tasks to check on the progress of the process: 

• For more details about the status, click the status link. For example, if a process 
is in the Ready status, you can click the Ready link in the Status column to see 
where the process is in the submission queue. 

• Check the Start Time column to see if the process has started running yet. 

• In the Search Results table, find the This Job's Items Processed / Errors / 
Total column. For some scheduled processes, this column shows what's 
getting processed and how things are going.  

• Click the View Log button, especially if your process has a blank This Job's 
Items Processed / Errors / Total column. The type of information in the log 
varies, depending on the process. You can open the log from here only for if 
the process is currently running. When the process is done, you might want to 
also take a look at the final log, if any, from the Details section. 
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To view output from scheduled process 

 

1. Click Navigator > Tools > Scheduled Process. 

2. Find your scheduled process and, if you need to, refresh the search results to see the 
latest status. 

3. Select the scheduled process. 

4. Go to the Output subsection in the Details section. 

5. Click the link in the Output Name column to view or download the output, which you 
can then print. 

6. To view or export the output in a different format: 

a. Click the Republish button. 

b. Click the Actions icon. 

c. Select Export, and then select a format. 
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2 BUDGET JOURNALS 

Budgetary Control provides these functions to manage the spending control process: 

• Performs funds check and funds reservation, when transactions are submitted or 

approved to determine whether spending is allowed. 

 

• Stores and maintains budgetary control balances, based on the budget calendar and 

control budget structure for these functions: 

1. Budget, categorized as initial and adjustment 

2. Consumption, categorized as expenditures, and other 

3. Funds available 

2.1 Enter Budgets 

Use these pages to enter budgets: 

No. Page Name Navigation 

1.  Enter Budgets Budgetary Control > Budgetary Control > Enter Budgets in 
Spreadsheet 

Table 2: Enter Budgets Navigation 

 

Figure 11: Budgetary Control Homepage  

In Budgetary Control Dashboard work area, user may find list of Budgets function in the task 

panel. This function will cover all budget enter, adjustment and transactions. 

 

Figure 12: Budgetary Control Tasks Panel List  
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Figure 13: Create Spreadsheet to Enter Budget Screen  

1. Fill up the information to upload the budget: 

Field Description 

Budget Usage Please select Budget Control validation 

Budget Entry Classification Select from List of Values 

Control Budget Select from List of Values (LSE DEPT BUDGET or 
LSE PROJECT BUDGET) 

Start Period Select Start Period 

End Period Select End Period 

Budget Entry Name Enter Budget Entry Name. System auto-generate 
the budget entry name, change if required. 

Budget Scenario Leave as it 

Enter Budget Amounts As Select from List of Values: 

1. New budget or replacement of current 
budget – For New Budget 

2. Addition to or Subtraction from current 
budget – For Adjustment Budget 

 

2. Once completed enter all required information, click . 

3. Open the downloaded excel spreadsheet. 
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4. Connect to Oracle and Sign In using your login. 

  

 
5. Here is the Spreadsheet look like. 

 

 

Figure 14: Enter Budget Spreadsheet  

 

 

 

 

6. Add new row if required. 

• Select on the row required, click on Insert. 



Olivestouch Technologies Sdn Bhd 
User Manual 

General Ledger Module v1.0 

 

Confidential  Page 20 of 79 

 

 
 

• You can remove “Triangle” marks if the row is not required, by double clicking the  

 
 

7. Fill up the information: 

• Enter the Budget Segment by double clicking Budget Segment (column F) 

• Enter the Budget Amount 

• Enter Comment if any 

 
8. After fill up the required information 

• Go to Enter Budget Amount tab 
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• Click on Submit button 

 
 

 
 

9. It will show which line has been successful and failed if any. 

• You may edit the line if required. 

 

 

10. Then, go to Schedule Process to review the status of the program: 

No. Page Name Navigation 

1.  Schedule Process Result Tools > Schedule Processes 

• There will be (3) reports generated: 

i. Import Budgets from Spreadsheet 

ii. Budget Import Results Report 
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iii. Budget Import Analysis Report 

• Go to required report (Budget Import Results Report). Once status change to 

Succeeded > view the output by click on Default Document. 

 

 

11. Here is the sample output of the upload budget: 
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2.2 Budgetary Control Balances 

In this task, user may check the budget balances and perform transfer of budget within same 

Control Budget. Use these pages to view budget inquiry: 

No. Page Name Navigation 

1.  Review Budgetary Control 
Balances 

Budgetary Control > Budgetary Control > Tasks > Review 
Budgetary Control Balances 

Table 3: Review Budget Balances Navigation 

 

Figure 15: Budgetary Control Homepage  

1. Go to Tasks > Review Budgetary Control Balances 

 

Figure 16: Budgets Tasks 

2.2.1 Budget Inquiry 

1. Choose the Control Budget 
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2. Fill up the search criteria. 

3. Next, click on Search button to execute. 

 

 
 

4. Choose the balance that require drilldown. For example, click on amount at Obligations 

column for this task. 

 

 
 

5. User may examine the Budget Transactions that impacts the Budget Balances. 

6. User may click to one of the Transactions or Related Transaction to view the 

transactions. 
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7. Related transactions will be showed. 

8. Finally, click on Done button to go back to the Review Balance screen. 

 

 
 

2.2.2 Transfer Budget 

1. Choose the Control Budget 

 

2. Fill up the search criteria. 

3. Next, click on Search button to execute. 
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4. Select the required budget segment. 

 
 
5. Click on Transfer Budget > From This Account 

6. A bubble prompt will appear shows the Budget Transfer Request From 

 
 

7. Select another budget segment. 

8. Click on Transfer Budget > To This Account 

 
 

9. A bubble prompt will appear shows the Budget Transfer Request To 

 
 

10. Click on  button. 

 

11. User will redirect to Budget Transfer Request window. 
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Field Description 

Budget Transfer Name System Generated (Changed if required) 

Budget Usage Select Budgetary Control validation from List of Values 

Justification Enter the justification of the budget transfer request 

Period Amount Enter the amount for Transfer From and Transfer To budget 
segment 

 

12. Next, click on Submit to proceed. Confirmation prompt will be appeared. Click on OK. 

 
 

13. Upon succeeded, user may review decreased and increased on Total Budget. 

 
 
Note: Period Amount for Budget Transfer From and Budget Transfer To must be equivalent. 
If not, error will be prompt. 
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2.3 Period Closing - Budget 

2.3.1 Budget Period 

Budget Period needs to be in Available for Budgeting or Open to be able to enter budget and 

must be in Open status to perform budget checking. Budget Period needs to be in Closed 

period before performing carry forward. 

Use these pages to open/closed budget period: 

No. Page Name Navigation 

1.  Manage Budget Statuses Budgetary Control > Budgetary Control > Tasks > Budget 
Period Statuses 

Table 4: Manage Budget Status Navigation 

 

Figure 17: Budgetary Control Homepage  

 

Figure 18: Budgetary Control Tasks Panel List (Budget Period Statuses) 

1. User will be redirect to Manage Budget Period Statuses page. 

• User may view the Current Period, Previous Period and Next Period statuses. 

Status Description 

Never Opened This is for new period 

Available for Budgeting Able to enter budget only 

Open Able to enter budget, and perform budget checking 

Close Pending 
To limit budgetary control validation while completing month-
end or year-end close tasks. 

Closed Not able to post budget and budget checking. 

Permanently Closed Not able to reopen the budget period. 
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Figure 19: Manage Budget Period Statuses Page  

2. Click on Control Budget required to update the Budget Status. 

3. Next, select Status from List of Values. 

4. Click on Save and Close button. 

 

Figure 20: Edit Budget Period Statuses Screen  

2.3.2 Carry Forward Activity 

Steps to perform carry forward activities: 

Step Program Description 

1.  Carry Forward 
Encumbrance 

This activity is to transfer encumbrance balance (obligation, 
commitment) from last period of current budget period to next fiscal 
year first open budget period. 

2.  Carry Forward 
Funds Available 

This activity is to transfer unspent budget amount from current 
period to the next period. 
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 Carry Forward Encumbrance 

Use these pages to manage encumbrance carry forward rules: 

No. Page Name Navigation 

1.  Manage Encumbrance 
Carry Forward Rules 

Budgetary Control > Budgetary Control > Tasks > Manage 
Encumbrance Carry Forward Rules 

Table 5: Manage Encumbrance Carry Forward Rules Navigation 

 

Figure 21: Budgetary Control Tasks Panel List (Manage Encumbrance Carry Forward) 

a) Manage Encumbrance Carry Forward Rules 

 

Figure 22: Manage Encumbrance Carry Forward Rules Screen  

 

1. Click on ‘+’ 

 

Figure 23: Create Encumbrance Carry Forward Rule Screen 
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2. Enter required information: 

Field Description 

*Name Enter Rule Name 

Description Enter Rule Description 

*Chart of Accounts Select LSE 

3. Click on ‘+’ to define the accounts range. 

4. Click on  > Add Fields  

5. Change from Equals to Between from List of Values > define the accounts range required. 

6. Click OK. 

    
 

7. Repeat step 4 to 6 to add more filter if required. 

8. Once done, click Save and Close. 

 

b) Carry Forward Encumbrance 

Prerequisite 

✓ Run receipt accruals in Oracle Purchasing. 

✓ Post all journal entries for encumbrance. 

✓ Close the last period of the fiscal year. 

✓ Open the first period of the next fiscal year. 

✓ Open the next encumbrance year. 

✓ Open the next budget year. 
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Use these pages to run carry forward encumbrance rule: 

No. Page Name Navigation 

1.  Manage Encumbrance 
Carry Forward Rules 

Budgetary Control > Budgetary Control > Tasks > Manage 
Encumbrance Carry Forward Rules 

Table 6: Manage Encumbrance Carry Forward Rules Navigation 

2. Select required rule, click on Generate. 

 
 

3. Fill up the parameter required: 

 

Figure 24: Generate Encumbrance Carry Forward Parameter  

 

Field Description 

Data Access Set System default – LSE MY 

Ledger System default – LSE MY 

Carry Forward Rule Select from List of Value 
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Field Description 

Encumbrance Type Select from List of Values: 

i. ALL 

ii. Obligation 

iii. Commitment 

iv. Invoice Oracle 

Mode Select Preview to view the expected result. Once 
confirmed, select Final. 

From – To Period Select from List of Value. 

Period can be selected once last period is Closed and next 
period has Open. 

 

4. Once completed > click on Submit  

Note: System will not be able to roll back the carry forward amount. 

 

5. Go to Scheduled Processes to review the output. 

 

Figure 25: Encumbrance Carry Forward Execution Report  

 

6. Once confirmed, Generate again the process and select Mode as Final. 
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c) Carry Forward Funds Available 

Use these pages to carry forward funds available rules: 

No. Page Name Navigation 

1.  Carry Forward Funds 
Available 

Budgetary Control > Budgetary Control > Tasks > Carry 
Forward Funds Available 

Table 7: Carry Forward Funds Available Navigation 

 

Figure 26: Budgetary Control Tasks Panel List (Carry Forward Funds Available) 

1. Fill up the parameter: 

 

Figure 27: Carry Forward Funds Available Parameter  

 

Field Description 

From Control Budget Select from List of Value 

From Budget Period Select last budget period from List of Value 

Balance Select from List of Value 

Target Control Budget Select from List of Value. Must be same as From Control 
Budget. 
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Field Description 

Classify Target Budget As Select from List of Value 

Budget Account Filter Leave as it 

 

2. Once completed > click on Submit  

 

3. Go to Scheduled Processes to review the output. 
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3 JOURNAL PROCESSING 

The ledger and subledger transactions are captured in these ways: 

• Creating journals manually 

• Creating journals using spreadsheets 

• Journals created automatically 

Use of these methods varies depending on: 

• The application that provides the data 

• The reason for the entry, such as error correction versus monthly entries 

• The tools available, such as the calculation engine used in the automation of journal 

entries 

Creating Journals Manually 

Enter Journal Manually is a process of manually creating journal entries in the system to record 

financial transactions in Oracle Fusion General Ledger. 

Journal entries are used to track and update the financial position of an organization by 

recording debits and credits in the appropriate accounts. 

Manually entered journal used for: 

Non-routine transactions: These are transactions that are not automatically generated 
by other submodules, like account receivables or accounts payable. 

Adjustments: To adjust financial records when automatic entries are not possible or 
when corrections are needed. 

One-time transactions: Such as specific accruals, allocations, or reclassifications that 
may not occur regularly. 

This method is the most time-consuming and prone to errors due to human involvement. 

 

Creating Journals in Spreadsheets 

It refers to the process of creating and importing journal entries using spreadsheet templates. 

This method is especially useful for handling large volumes of journal entries, such as month-

end adjustments, intercompany transactions, or bulk allocations. It simplifies the process by 

allowing users to input journal data offline and then easily import it into the system. 

Enter journal using spreadsheet usually used for: 

Bulk Journal Entries: Entering multiple journal entries for month-end closing or periodic 

adjustments. 

Repetitive Transactions: Handling recurring entries like accruals, allocations, and 

transfers across multiple accounts. 

Overall, entering journals in spreadsheets is a more streamlined method compared to manual 

entry, especially for large or repetitive journal entries, while still allowing the flexibility of offline 

work. 

Note: Spreadsheets are created as templates for recurring entries and then each month, 

simply update the data and upload. 
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3.1 Journal Entry and Posting 

3.1.1 Create Journal 

Use these pages to create journals. 

No. Page Name Navigation 

1.  Create Journal General Accounting > Journals > Tasks > Create Journal 

Table 8: Create Journal Navigation 

 

Figure 28: General Accounting Homepage 

1. Go the Task > Create Journal. 

 

Figure 29: Journal Work Area 

2. Enter all the required information. 

Field Description 

Journal Batch Enter Journal Batch 

Description Enter Journal Batch Description 



Olivestouch Technologies Sdn Bhd 
User Manual 

General Ledger Module v1.0 

 

Confidential  Page 38 of 79 

 

Field Description 

Balance Type System default to Actual 

Accounting Period Select from List of Values. System will default to current 
open period. 

Attachments Select End Period 

Journals Enter Journal name 

Description Enter Journal Descriptions 

Ledger Select from List of Values (if any) 

Accounting Date Enter Accounting Date required 

Category Select from List of Values 

Currency Select from List of Values (if required) – System default to 
Reporting Currency Ledger. 

 

 

Figure 30: Create Journal Page (Journal Batch and Journal Section) 

Field Description 

Account Select Account Code Combination 

Entered Debit Enter Debit Amount 

Entered Credit Enter Credit Amount 

Description Enter Description Line (if any) 
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Figure 31: Create Journal Page (Journal Lines Section) 

 

3. After completed editing your Journal Entry details, you may click Save button, 
Complete button or Post button. 

Button Description 

Save Journal will be saved with status Incomplete 

Complete Journal is Complete and ready to be Posted 

Post Journal is Complete and Posted the journal once Approved 

Cancel Journal will not saved 

 

 

 

4. Once completed the Journal Entry, user may directly click on Post. 

 

A warning message will appear, user may click on Yes. 

 

5. Next, a confirmation message will appear. User may proceed by clicking on OK. 
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3.1.2 Create Journal in Spreadsheet 

Pre-requisite 

✓ Need to have ADF Desktop Integration tools installed. 
✓ Navigate to the Tools work area and select the Download Desktop Integration Installer 

link. Please refer to the User Manual for Installation ADFdi for further guidance. 

 

3.1.3 Create Journal in Spreadsheet 

Use these pages to create journals using Spreadsheet. 

No. Page Name Navigation 

1.  Create Journal in 
Spreadsheet  

General Accounting > Journals > Tasks > Create Journal in 
Spreadsheet 

Table 9: Create Journal in Spreadsheet Navigation 

 

Figure 32: General Accounting Homepage 

 

Figure 33: Journals Task 
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1. Open or Save as the excel file. 

 

 

2. Connect to Oracle and Sign In using your login. 

 

 
  

3. Journals workbook can be used for processing high-volume journal entries. You can 
prepare the journals offline, share the workbooks for review, or save them for recurring 
entries. 

Create Journals workbook has two worksheets: 

i. Single Journal 

User can create a journal for one ledger, like using the Create Journal page in the 
application 

ii. Multiple Journals 

User can create multiple journals and multiple journal batches for different ledgers. 
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Figure 34: Create Journal Template (Header) – Single Journal 

 

Figure 35: Create Journal Template (Header) – Multiple Journals 

Field Description 

a) Journal Header 

Data Access Set System default 

Journal Enter Journal name 

Description Enter Journal Descriptions 

*Ledger Select from List of Values 

*Accounting Date Enter Accounting Date required 

Adjusting Period Select from List of Value (if required) 

*Source System default 

*Category Double Click to Search for values 

Reversal Period Select from List of Values (if required) 

Reversal Date Leave Blank 

Reference Date Leave Blank 
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Field Description 

b) Journal Lines 

Account Code Combinations 
(Column E to J) 

Enter or Double Click to Search for values 

Currency Enter Currency Code (example: MYR) 

Entered Debit Enter Debit Amount 

Entered Credit Enter Credit Amount 

Line Description Enter Line Description (if required) 

 

 

Figure 36: Create Journal Template (Lines) – Single Journal 

 

Figure 37: Create Journal Template (Lines) – Multiple Journals 
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4. Total Entered Debit & Total Entered Credit will be auto calculated. 

Next, go to Create Journal tab > Submit 

 

5. Click on Submit button to proceed. 

  

 

6. You will receive confirmation in the Row Status once your Journal Entry details have 

been successfully submitted. 

 

Figure 38: Create Journal Template (Row Status) 
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3.1.4 Copy Journal 

Use these pages to manage journals. 

No. Page Name Navigation 

1.  Manage Journals General Accounting > Journals > Tasks > Manage Journals 

Table 10: Manage Journals Navigation 

 

Figure 39: General Accounting Homepage 

 

Figure 40: Journals Task (Manage Journals) 

 

2. Enter the relevant criteria. 

Select Batch Status from List of Values. (Select Posted for this task). 

Click on the Search button. 

 

Figure 41: Manage Journals Page 
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3. Click on the required Journal 

 

Figure 42: Manage Journals Page (Search Result) 

 
Figure 43: Edit Journals Page 

4. Click on Batch Actions > Copy 

 
Figure 44: Create Journals Batch Prompt Window 

Field Description 

*Journal Batch System default (User may change as required) 

Accounting Period Select from List of Values 

*Accounting Date System default (User may change as required) 
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5. Once fill up all information, click on OK. 

 

Figure 45: Edit Journals Page (Source: AutoCopy) 

6. Journal will be created with Source AutoCopy 

7. User may update journal as required. 

8. User may proceed follow step as Section 3.1.1. 

 

3.2 Manage Approval 

Use these pages to approve/reject journals. 

No. Page Name Navigation 

1.  Manage Approvals General Accounting > Journals > Tasks > Manage Approvals 

Table 11: Manage Approvals Navigation 

 

Figure 46: General Accounting Homepage 
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1. Approver may click go to Tasks > Manage Approvals 

 

Figure 47: Journals Task 

2. Choose the desired Journal row. 

Review the journal information. Click Approve / Reject to proceed. 

 

 

3. Approver may Approve / Reject thru Notification Bells. 
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4. Approver also will receive email notification. User may Approve / Reject thru e-mail. 

 

 

Notes:  

• Please remove the signature of your email. 

• Ensure to enter comment above the line. 

 

 

3.3 Posting Journal 

Journal posting is a process that updates balance in General Ledger accounts to reflect any 

entity’s business transactions and provides data for financial reporting. 

You can post a journal after when you created it, or you can post it later by selecting it from 

the list of available journals. 

You can post journals one a time or in batches. You must have the journal period open before 

you can post and have access to the security classes of every entity for the detail lines and 

have write access to every dimension member selected for each line. 
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3.3.1 To Post Journals Manually 

Use these pages to manage journals. 

No. Page Name Navigation 

1.  Manage Journals General Accounting > Journals > Tasks > Manage Journals 

Table 12: Manage Journals Navigation 

 

Figure 48: General Accounting Homepage 

 

Figure 49: Journals Task (Manage Journals) 

 

2. Enter the relevant criteria. 

Select Batch Status from List of Values. (Select Unposted for this task). 

Click on the Search button. 

 

Figure 50: Manage Journals Page 

3. Select the required Journal. 

4. Click on Post Batch button to proceed. 
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Figure 51: Manage Journals Page 

5. Or user may click on required journals to review. 

6. Click on Post to proceed. 

 

Figure 52: Edit Journal Page 

 

3.3.2 To Run AutoPost Criteria Set 

Use these pages to Run AutoPost journals. 

No. Page Name Navigation 

1.  Run AutoPost General Accounting > Journals > Tasks > Run AutoPost 

Table 13: Manage Journals Navigation 

 

Figure 53: Journals Task (Run AutoPost) 
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Figure 54: AutoPost Journals Process 

1. Select existing Autopost Criteria Set from the List of Values. 

2. Click on Submit button. 

 

3.4 Reversal Journal 

You can reverse journals manually by selecting a reversal action in the user interface, or you 

can reverse journals automatically by running a process. Decide which approach is best for 

journals such as accruals, estimates, errors, temporary adjustments, or reclassifications that 

require reversal. Reversing journals saves you time and helps prevent data entry errors. 

You can enter a reversal period and method at any time, even after the journal is posted. If 

applicable, the following values also display in the Reversal tab: 

• Reversal Journal: If you're reviewing a journal that was reversed, this setting displays 

the name and link to the reversal journal. 

• Originating Journal: If you're reviewing a reversal journal, this setting displays the 

name and link for the journal that was reversed. 

Each reversal journal is generated within its own reversal batch, and the batch name begins 

with the word "Reverses" 

 

3.4.1 Manual Journal Reversal 

You can manually reverse posted journals that are eligible for reversal. 

When you reverse a batch, a single reversal request is submitted. However, the reversal 
journal for each journal in the reversed batch is still generated in its own journal batch.  

Use these pages to manage journals. 

No. Page Name Navigation 

1.  Manage Journals General Accounting > Journals > Tasks > Manage Journals 

Table 14: Manage Journals Navigation 
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Figure 55: General Accounting Homepage 

 

Figure 56: Journals Task (Manage Journals) 

 

1. Fill up the search criteria and click on Search button to proceed. 

 

Figure 57: Manage Journals Page (Search Section) 

 

2. Select on the Journal. User can direct reverse journal by clicking Reverse Batch button 
in this screen. 
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Figure 58: Manage Journals Page (Reverse Batch Navigation) 

 

3. Or user can review the journal. Click the journal to review. 

4. After review, Click on Batch Action > Reverse. 

 

Figure 59: Edit Journal Page (Reverse Navigation) 

5. Choose the Reversal Period and Reversal Method from list of values. Then click the OK 
button to complete. 

 

Figure 60: Reverse Journal Batch Screen 

 

 

Figure 61: Message Box 
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6. User again click on the original journal. User click on Show More > Reversal tab, Reversal 

Status now has changed to Reversed. 

7. Reversal Journal will be show as Reverses journal created by the system. 

 

 

8. If user click on Reversal Journal, screen will redirect to the journal. 

9. On Reversal tab, it will show the Original Journal that are being reversed. 

 
 

3.4.2 Run AutoReversal Journal 

User can Run AutoReversal journal to reverse posted journals that are eligible for reversal, 
based on the criteria that have been set. 

Use these pages to Run AutoReversal journals. 

No. Page Name Navigation 

1.  Run AutoReversal General Accounting > Journals > Tasks > Run AutoReversal 

Table 15: Run AutoReversal Navigation 
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Figure 62: Journals Tasks 

 

Figure 63: Run AutoReverse Journal Process 

 

3.5 Enter Daily Rate 

Pre-requisite 

✓ Need to have ADF Desktop Integration tools installed. 

Use these pages to enter daily rates 

No. Page Name Navigation 

1.  Manage Currency 
Rates 

General Accounting > Period Close > Tasks > Manage 
Currency Rates 

Table 16: Manage Journals Navigation 

 

Figure 64: Period Close Homepage 
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Figure 65: Multicurrency Tasks (Manage Currency Rates) 

 

2. Click on Create in Spreadsheet 

 

Figure 66: Currency Rates Manager Screen 

 

Figure 67: Create Daily Rates Spreadsheet 

Field Description 

*From Currency Select from List of Values 

*To Currency Select from List of Values 

*Conversion Rate Select from List of Values 

*From Conversion Date Select from List of Values – period to revalue balances 

*To Conversion Date Enter Accounting Date required 

Conversion Rate Enter Accounting Date required 
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Figure 68: Create Daily Rates Spreadsheet 

3. Once user have completed all required information, go to Create Daily Rates tab > click 

on Submit. 

   

Figure 69: Submission Options and Confirmation Prompt Box 

4. To review Daily Rates uploaded. User go to General Accounting > Period Close > 

Tasks > Manage Currency Rates 

 

Go to Daily Rate tab. Enter all required Search criteria. Next, click on Search. 

 

 

Figure 70: Currency Rates Manager Screen 
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3.6 Revaluation 

Pre-requisite 

✓ Revaluation criteria has been created. 

✓ Period End Rate has been defined. 

✓ There are balances in foreign currency in defined Revaluation Account. 

Use these pages to revalue balances. 

No. Page Name Navigation 

1.  Revalue Balances General Accounting > Period Close > Tasks > Revalue 
Balances 

Table 17: Manage Journals Navigation 

 

Figure 71: General Accounting Homepage 

 

Figure 72: Multicurrency Tasks (Revalue Balances) 

 

2. Choose the schedule name. Click on the Generate button to proceed. 

 

Figure 73: Manage Revaluations Page 
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Figure 74: Generate Revaluation Balance Process 

Field Description 

*Data Access Set System default 

* Ledger or Ledger Set System default 

*Revaluation Select from List of Values 

*Accounting Period Select from List of Values – period to revalue balances 

*Accounting Date Enter Accounting Date required 

*Rate Date Enter Accounting Date required 

3. Once fill all required information, click on Submit to proceed. 

4. Next, user may review the Revaluation created journal in Manage Journals screen. 

 

Figure 75: Manage Journals Page (Search Section) 
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4 INQUIRY GL BALANCES 

4.1 Inquiry Accounts and Perform Drilldown 

Use these pages to inquire on detail balances. 

No. Page Name Navigation 

1.  Inquire on Detail 
Balances 

General Accounting > Period Close > Tasks > Inquire on Detail 
Balances 

Table 18: Manage Journals Navigation 

 

Figure 76: General Accounting Homepage 

 

Figure 77: Balance Inquiry Tasks (Inquire on Detail Balances) 

Saved Search 

If you search often using the same criteria, create a saved search. 

2. Enter your search criteria. 

 

Figure 78: Inquire on Detail Balances Screen 

3. Click Save. 
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Figure 79: Create Saved Search Prompt 

 

4. Enter a name for the search. 

5. Tick Set as Default (if required) 

Optionally, make the saved search the default search. When you land on the Inquire on 

Detail Balances page, the default saved search criteria is populated automatically. 

6. Click OK. 

 

 

Figure 80: Inquire on Detail Balances Screen (Saved Search) 

 

Search Results 

Here are a few things you can do with the search results. 

• Drill to the journal lines (for actual balances) and then drill to the journal entry or 
subledger transactions. 

• Export the balances to Excel. 

 

Figure 81: Inquire on Detail Balances Screen (Search Results) 
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Here is the process drill down the balance to the transaction level 

1. Fill up the search criteria. Next, click on Search button to proceed. 

 

Figure 82: Inquire on Detail Balances Screen 

2. It will show the balance by period of the account code combination. 

3. Click on the balance in the column Period Activity to drill down further. 

 

 

Figure 83: Search Results Page 

4. It will redirect to Journal Lines for that period. 

5. Click to one of the Journal. 

 

 

Figure 84: Journal Lines Page 

6. It will show the Journal Entry. 
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Click one of the balances either Debit or Credit to drill down further. 

 

 

7. It will show the summary level of the transaction. Click on View Transaction button to 

drill down further. 
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8. It will show the details of the transaction. 
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5 PERIOD CLOSING – GENERAL LEDGER 

Here are some checklists before the period closing: 

✓ Complete entering all regular and adjusting journals for the period in your ledger.  

✓ Post all unposted journals.  

✓ Run Revaluation. 

✓ Close period for all subledger. 

✓ Close your budget period. 

✓ Close your accounting period. 

5.1 Complete the Incomplete/Required Attention Journal 

Use these pages to manage journals. 

No. Page Name Navigation 

1.  Manage Journals General Accounting > Journals > Tasks > Manage Journals 

Table 19: Manage Journals Navigation 

 

Figure 85: General Accounting Homepage 

 

Figure 86: Journals Task (Manage Journals) 

 

1. From Journal Dashboard, tab showed: 

i. Requiring Attention 

• User may see the issue in Issue column. 

• User may click the journal and review it. 

• Post or delete the journal if required. 
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Figure 87: Journals Page (Requiring Attention tab) 

 

ii. Incomplete 

• Journals that yet completed will be in Incomplete tab. 

• User may click the journal in Journal Batch column and review it. 

• Post or delete the journal if required. 

• User may select on required line and click on Mark as Complete. 

 

Figure 88: Journals Page (Incomplete tab) 

 

iii. Import Errors 

• If there are any errors while importing the journals, it will show in this tab. 
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5.2 Open or Close Period 

Use these pages to open or close period. 

No. Page Name Navigation 

1.  Manage Accounting 
Periods 

General Accounting > Period Close > Tasks > Manage 
Accounting Periods 

Table 20: Manage Accounting Periods Navigation 

 

Figure 89: General Accounting Homepage 

 

Figure 90: Manage Accounting Periods Tasks 

 

1. Close Status Dashboard. 

Then, you can change the Accounting Period and click the refresh button to view the 
period status. 

Click one of the modules to review the period. 

 

Figure 91: Close Status Dashboard 
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2. Here is the period for General Ledger Module. 

Select required Accounting Period. Click on Open Period / Close Period button 

required. 

3. Upon Year-End Processing, click on Open Next Encumbrance Year to open Next 

Encumbrance Fiscal Year. 

 

 

Figure 92: Edit Accounting Period Statuses 

 

No. Status Description 

1 Future Enterable You can enter transaction but cannot posted/completed 

2 Open You can enter transaction and posted 

3 Close You cannot enter transaction, and the period can be reopened 
back 

4 Permanently Close The period is permanently Closed and cannot reopen back 

Table 21: Accounting Period Status 

 

Find which period to close. Once you select the Accounting Period, Close Period button will 

be enabled (it happens only if the Accounting Period never been closed yet, if not Open 

Period button will be enabled) and vice versa. 

After completing, you will get confirmation popup and receive processed number that it has 

been submitted. 

 

4. If user plans to open more than one period at a time, user may click on Actions > 

Open Target Period 
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5. Select Target Period from List of Values. 

6. Click on Open. 
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6 REPORT SUBMISSION 

6.1 Standard Report 

Use these pages to open or close period. 

No. Page Name Navigation 

1.  Scheduled Processes Tools > Scheduled Processes 

Table 22: Manage Accounting Periods Navigation 

 

Figure 93: Tools Homepage 

 

1. Click on Schedule New Process to search for the report. 

 

 
2. Enter Name of the report > click on OK. 
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Oracle General Ledger provides predefined reports that cover the following areas: 

• Account Analysis 

• Journals 

• Trial Balance Reports 

 

Account Analysis 

Name Description 

Account Analysis 

 
Prints balances by account segment and a secondary segment 
for each journal entry. 

Lists the subledger document number for transactions imported 
from subledgers. 

  

General Ledger Account 
Details Report 

 
Provides journal information to trace each transaction back to 
its original source. 

Prints a separate page for each balancing segment value. 

 
For each journal line, prints: 
 

The account affected, the concatenated description, the journal 
line amount, and the beginning and ending account balance. 

Journal details including source, category, journal name, and 
effective date. 

Lists accounts in ascending order by account segment value. 

Prints a CR next to credit amounts. 

  

Table 23: List of Account Analysis Reports 

Journals 

Name Description 

Journals Report 
Provides journal activity for a given period or range of periods, 
balancing segment value, currency, and range of account 
segment values. 

Journals Batch Summary 
Report 

 
Provides information about actual balances for your journal 
batches, source, batch, and posting dates, total entered debits 
and credits. Sorts the information by journal batch within each 
journal entry category. 

Includes totals for each journal category and a grand total for 
each ledger and balancing segment value combination. 

Doesn't report on budget or encumbrance balances. 
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Journals Details Report 

 
Provides information about manually entered journals prior to 
posting, including field by field, all data entered into the 
applications or data imported from external sources. 
  

Table 24: List of Journals Reports 

 

Trial Balances 

Name Description 

Trial Balance Report 
Provides summarized actual account balances and activity by 
ledger, balancing segment, and account segment value.  

Trial Balance - Average 
Balances 

 
Provides a listing of ending balances and average balances 
for selected accounts based on an effective date specified. 

Prints the ledger currency or foreign-entered balances. 

Displays period, quarter, and year average-to-date balances. 

  

Note: Request additional information by specifying balancing 
segments and account ranges. 
  

Table 25: List of Trial Balances Reports 
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7 GENERAL LEDGER MAINTENANCE SETUP 

The maintenance setup can be performed by using Setup and Maintenance. In this Chapter, 

we will be discussing on setup and maintenance for Chart of Accounts (COA), Account 

Hierarchy and Document Sequence. 

 

 

Figure 94: Settings and Actions 

 

Setup and maintenance work area can be accessed from Settings and Actions. It can also be 

accessed by using Others from navigator. 

 

 
 

7.1 Maintain Chart of Accounts 

Use this page to maintain chart of accounts. 

No. Page Name Navigation 

1.  Manage Chart of 
Accounts Value Sets 

Settings And Actions > Setup and Maintenance > Manage Chart 
of Accounts Value Sets 

Table 26: Manage Chart of Accounts Value Sets Navigation 

 

1. Navigate to setup and maintenance work area. 
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Figure 95: Financial Setup and Maintenance Work Area 

User click on Financial Reporting Structures > Manage Chart of Accounts Value Set or user 

may directly Search Tasks: Manage Chart of Accounts Value Set > click on . 

 

 

Figure 96: Manage Chart of Accounts Value Sets Screen 

 

User may enter keyword at Value Set Code field (Keyword: LSE) > click Search. 

 

 
 

Select required Value Set Code to add new code > click Manage Values. 

 

User will be directed to Manage Values page. 

 

Directly, click on Search. 

 

Next, click on ‘+’. 
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Fill required information: 

 
 

Field Description 

*Value Enter Value – user may enter alphanumeric. Limit as per 
below: 

i. LSE_COMPANY – 2 characters 

ii. LSE_INTERCO – 2 characters 

iii. LSE_ACCOUNT – 6 characters 

iv. LSE_COST_CENTER – 5 characters 

v. LSE_PROJECT – 7 characters 

vi. LSE_FUTURE – 4 characters 

Description Select from List of Values 

Enabled • Tick to enable the value.  

• Untick if the value not been used. 

*Summary • Select No – if the value is Child 

• Select Yes – if the value is Parent 

*Allow Posting • Select No – if the value is Child 

• Select Yes – if the value is Parent 

*Allow Budgeting • Select Yes 
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Field Description 

*Account Type Select from LOV either Asset, Expense, Liability, Owner’s 
Equity or Revenue 

*Third Party Control Account Select No 

*Reconcile Select No 

Financial Category Leave blank 

 

Lastly, click on Save and Close. 

 

7.2 Maintain Accounting and Reporting Sequences 

Use this page to maintain accounting and reporting sequences. 

No. Page Name Navigation 

1.  Manage Accounting 
and Reporting 
Sequences 

Settings And Actions > Setup and Maintenance > Manage 
Accounting and Reporting Sequences 

Table 27: Manage Accounting and Reporting Sequences Navigation 

2. Navigate to setup and maintenance work area. 

  

Figure 97: Financial Setup and Maintenance Work Area 

3. Search keyword LSE at Query by Example > click Enter. 

 

Figure 98: Manage Accounting and Reporting Sequences Screen 



Olivestouch Technologies Sdn Bhd 
User Manual 

General Ledger Module v1.0 

 

Confidential  Page 78 of 79 

 

 

4. Select required sequences, let say LSE Accounting Sequence - GL. 

5. Select previous sequences > click on duplicate button ( ). 

6. Enter new sequence’s Name, change the Effective Start Date, Effective End Date 

and Initial Number. 

 

Figure 99: Edit Sequence Page 

 
7. Repeat for LSE Accounting Sequence – SLA.  



Olivestouch Technologies Sdn Bhd 
User Manual 

General Ledger Module v1.0 

 

Confidential  Page 79 of 79 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

End of Document 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


